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GRADUATE
COLLEGE

Table of Contents Manual

This manual provides:

1. Guidelines for how to properly format the Table of Contents.

2. Instructions on the two ways of generating a Table of Contents in Microsoft
Word.

3. Table of Contents examples.

Sections:

Section 1: Formatting the Table of Contents (p.2)

Section 2: Manually create a Table of Contents in Microsoft Word (p. 4)
Section 3: Create a Table of Contents Automatically in Microsoft Word (p. 8)

Table of Contents examples (p. 11)
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Section 1: Formatting the Table of Contents

e ATable of Contents (TOC) must appear in your thesis or dissertation document.

e The items that should be listed on the TOC should include all pages from the
Abstract through the Curriculum Vitae. Thus, your TOC includes:
o Abstract (starts on page iii)
Acknowledgements (optional)
Dedication (optional)
Preface (optional)
Table of Contents (optional to put it on the TOC of your
thesis/dissertation)

(@)
(@)
(@)
(@)

o List of Tables (if applicable)

o List of Figures (if applicable)

o Any other lists including: List of Definitions, List of Algorithms, List of
Equations, etc. (if applicable)

o Main body of your text (e.g., chapter titles, headings, subheadings)

o Appendix or Appendices (optional)

o Bibliography

o Curriculum Vitae

e As the last document of your text, the Curriculum Vitae is the last item of your
TOC.

e The page numbers listed on your TOC must match the page numbers of items as
they appear in the text.

e The titles listed in the TOC must match the titles as they appear in the text.

e In general, your document needs to be broken down into Chapters/Sections.
Chapters must appear in the TOC.

e The title must match exactly between the TOC and the text. The page number
must also match exactly between the two.
o For example, if the chapter title, “Chapter 1 Introduction: An Unexpected
Beginning,” is used on page 5 of the text the Table of Contents should list:

Chapter 1 Introduction: An Unexpected Beginning........ccccoeevevvrrrrevvereeneeeeennn. 5

e Chapter sections and subsections should appear consistently in the TOC. If a level
of subsection is included in the TOC, then all subsections at that level must be
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listed in the TOC. Subheadings and subsections are not required to be listed in
your TOC.

Creative dissertations (novellas, novels, and poetry) that do not have a chapter
structure should have at least 1 major section listed in addition to their front
materials and Curriculum Vitae. Collections of short stories should list the stories
contained in the collection as sections in the TOC.
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Section 2: Manually Creating A Table of Contents in Microsoft

Word

There are two ways that you can generate a TOC in Word: typing it manually or creating

it automatically. This section discusses the former.

Typing the TOC Manually:

This method involves 1) typing the entries (chapter titles, headings, and subheadings)
and 2) using either tabs to get the dotted lines (ellipses) or dot leaders between each
entry and its respective page number.

On the TOC page:
1. Type the first entry

2. Press Tab and then type its respective page number (remember to make sure the
respective page number matches exactly between the document and what is

listed in the TOC

3. Then select the Tab stop character. In order to show the Tab stop character, click
the Home tab. Then click Show/Hide in the paragraph group.

P ERES B - @ )
@ Layout | Document Elements | Table harts A F~
Font Styles Insert Themes
Cambria(Body) |v|[12 |+||A~ A~ || &~ |4 |} M= k= AaBbCeDAE(| AR~ ]A:[v&j' \ﬁL'
B | IJU ~|=¢| & A A= | A B H == |emein] — G o = s
P Sl B A el E o — = =

Home Tab

Paragraph Group

Show/Hide

4. Click the arrow found at the bottom left hand corner of the paragraph group.

5. This launches the Paragraph Dialog Box. [Alternatively, you can click the Format
tab on the top, then click Paragraph. This will also launch the Paragraph Dialog

Box].
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6. Click the Tabs button.

7.

Paragraph

LLEEE LR B Line and Page Breaks

Alignment: | Left Outline Level: | Body text
Indentation
Left: 0" 2| Special: By:
(none) a <]
Right: 0"
Spacing
Before: 0 pt 2 Line spacing: At:
Single B )
After: 0 pt z

Don't add space between paragraphs of the same style

Preview

Type 6.4” under the Tab stop position. This means that your number will end at
the 1” margin (Remember all margins, including the left margin, for the thesis or
dissertation must be 1”).

Tabs
Tab stop position: Default tab stops:  0.5" o
6.4"
Alignment
6.4"
Left Decimal
Center Bar
© Right
Leader
1 none &) momme
Q2. 4

Tab stops to be cleared:

Set Clear Clear All Cancel ﬁ



8. Under Alignment, click Right.

Tab stop position:

6.4'

6.4"

Tab stops to be cleared:

Tabs

Default tab stops:  0.5" c
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Alignment
Left Decimal
r Bar
© Right
Leader
1 none 3 ----
0O2.... 4

Set

Clear All cancel | (TSN

9. Under Leader, chose option 2 for ellipses in your Table of Contents. Or, choose

option 1 if the use of leaders in the text is prohibited.

Tab stop position:

6.4"

6.4"

Tab stops to be cleared:

Tabs
Default tab stops:  0.5" z
Alignment
Left Decimal
Center Bar
© Right

Leader

Set

10. Click Set and then OK.

Clear All Cancel (S

11. Press Enter. Type your next entry, press Tab, and then type the entry’s

respective page number.

12. Repeat until your Table of Contents is finished.
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Note: Primary, secondary, tertiary, etc., levels of headings should be formatted per the
rules laid out in your style guide. Your style guide will breakdown how each level of
heading will appear in your text and in your Table of Contents.
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Section 3: Create a Table of Contents in Microsoft Word
Automatically

In order to create a TOC in Microsoft Word automatically, you need to have already
applied heading styles to the major heading as well as all subheadings in your thesis or
dissertation document. For help applying heading styles to these items please see the
pdf Headings and Subheadings located in Section 5: Organization of the Thesis and
Dissertation under Main Body of Your Text on the Graduate College Thesis and
Dissertation website http://www.unlv.edu/graduatecollege/thesis. Assigning a style to
each heading and subheading enables Word to track the location of these items. This
then allows Word to create a list of them or a TOC.

Generating a TOC Automatically:

1. Since you will be generating the TOC from heading styles, it is important to
determine that all major headings and subheadings have the heading style that
you intended. All of your major headings (e.g., chapter headings, Abstract, Table
of Contents, etc.) should all use the Heading 1 style, all of your primary or first-
level subheadings should all use the Heading 2 style, and so on.

2. Go to your currently blank Table of Contents page in your document. If you did
not save a page for the Table of Contents, then please add it now. Make sure
your major heading (Table of Contents) follows the other major headings style.

3. Go to the References Tab (alternatively you can click on the Document Elements
tab).

4. Click on the Table of Contents. It is located on the farthest left hand side of the
References ribbon.

A Home Layout Document Elements | Tables Charts SmartArt Review

Table of Contents Header and Footer Citations References Text Eleme

Insert Pages
-, a
== v - v = v o , = APA = . AS| v
Cover Blank Break Insert 4% = Header Footer Page#  Footnote Endnote lﬁ Manage Bibliography ‘{l'
v, --1|---.-.-E-.-1---1|---:---2|---1---3|---.---4|---1---5|---,-.-g_\,-.-.---7|-

5. Choose “Insert Table of Contents.” The Table of Contents box appears. Click on
the tab labeled “Table of Contents.” A similar image should appear.
6. Choose the Options button.

# Home Layout Document Elements | Tables Charts SmartArt Review

Insert Pages Table of Contents Header and Footer Citatic

==

=== v v Heading 1............. 1
- - Heading 2
e

v v p-
= = 1

Header  Footer Page # Footnote |

Cover Blank Break

e 1|.g

R T


http://www.unlv.edu/graduatecollege/thesis
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7. The menu “Table of Contents Options” appears. Here is where you can choose
which headings and subheadings to include on the Table of Contents.

8. At the very minimum, Heading 1 must be on the TOC. Thus, the corresponding
TOC level must be 1. The rest of the Heading styles are optional to place on the
TOC, but their TOC level should correspond with the subheading level. For
example, primary or first level subheadings are Heading style 2 and their TOC
level is 2, secondary or second level subheadings are Heading style 3 and their
TOC level is 3, and so on. If you do not want a Heading style to appear on the
Table of Contents then remove the TOC level number.

Table of Contents Options

Build table of contents from:

Styles
Available styles: TOC level:
8
Balloon Text t
/ v Heading 1 1
¥
v Heading 2 2
fl
v Heading 3 3
Heading 4
3 Heading 5

Table entry fields

] Reset Cancel | QUOIONN |

9. Once you are finished, click OK. Click OK again on the Table of Contents box. This
should generate your TOC on the Table of Contents page.

Note: If you see mistakes in your headings or subheadings (e.g., spacing problems,
misspellings, etc.) on the Table of Contents page, do not correct the mistakes on the
Table of Contents page itself. Rather, go to the heading or subheading in your document
and make the necessary corrections. You will need to update the Table of Contents to
reflect the changes.

Updating the Table of Contents:

1. Go back to the References tab.
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In the Table of Contents section (farthest left-hand corner), you will see “Update

Table.”

3. Select this option and your Table of Contents will be updated.

A Home |

== v

Cover

Insert Pages

Blank

Layout

A4

Break

‘ Document Elements ]
Table of Contents

Heading 1.........

Heading 2......
Heading 3 .

-2 | P

10

Tables J Charts | SmartArt J Review |
Header and Footer Citati
v v -~
L | =l | #] i
Header Footer Page # Footnote
T s B B ART- | A SRCRCANT:| [
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Sample Table of Contents: No Subheadings

Table of Contents

Y o1 1 T PSPPSR PRP PSPPI iii
ACKNOWIEAZEMENTS ...ttt e e e e e s s e e e e e e e e s e s sabbtaaeeeeesessnnnes iv
(D<o [ oF: 4T o [PPSO PSPPI vi
LISt OFf TABI@S . e e s nre e e X
LIST Of FIUIES .nnitieeeeee ettt e sttt e e e e e e s ettt e e e e e e e s s sababaaeeeeeeessssnbbaneeeeeeenan Xi
(@1 a =Y o] (=Lt R [ oY o T [T oY o 1
Chapter 2: Historical BaCkgroUNd..........cooiiuiiiiiiiiiie ittt e e e e e s s 14
(0 a Y o] (= g B Y/ = o g ToTo Fo] Lo =4 VAT 44
(@ g Y o T g A o= Y £ 1 102
Chapter 5: CONCIUSION ..uuiiiiiiiiiiiiiiieeee e e e e e s e e e e e s s s st aaaeeeeesesnsanees 139
RS E=T =T o Tol TR PR PPR PRSP 169
CUITICUIUM VLA ettt ettt ettt e e e et e e s e sbe e e e s eabbbeeesanbbeeeeenns 182

11
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Sample Table of Contents: With Subheadings

Table of Contents

AcknowledgmENtS v
Ry d o A -] o 1T PPPPPPPPRt vii
LIST Of FIBUIES  eeeeiiiei ittt e e e e s e sttt e e e e e e e e s s abbbaeeeaeeeesennsssenes ix
[ o) i Lo [UF: | o] o 13U PPP SR X
Chapter 1: IntrodUcCtion oo e e e e e s aaa e 1
OVEIVIBW ceiiiiiii ettt sttt e e e e e e ettt et e s s e e e e eeaa b e e s e e eeteaessaaaseeeesanessnnannnsssns 2
27T PO PP PP PPPPPRPPPIRt 3
Why Bees are Better than Wasps .......uvveieiiiiiiiiiiiiieeeee et e e svaee e e e e e e 3
Context of Little Black Rain Cloud Incident (1907) .....covvvvvviiiviieiiiiiiieeeeeeeeeeeeeeeeeeeeee, 4
American Foulbrood (AFB) diSEASE  ..oeeeviiiiiiiiiieeeieeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 4
Current AFB disease ManagemeENnt  ..ooooiiieiiiiiiiiie e e e ee e e e e e e e e e r e 7
Chapter 2: Bees Make HONEY s 19
ADSEIACT oo 19

g T oY [T ox 1 o PPNt 20
Methods and MaterialS  ........eueiiiiiiiiiiiiiiiiiere e aeereeerrerrerarrerarrrrrrerrerrrarrrenes 22
2T P PPPPPPPPRt 28

DT of B 13 [o] o PPN 31
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Chapter 3: Low Carb Diets Limit Honey Consumption oo 48
Y o1 1 T PSP RO PPRPPSP 48
Literature REVIEW oo 49
BEES N BOOKS oottt e e 50
BEES N CINEMA oo e e 52
BEES ON @ PlAaNe e 55

Chapter 4: Low-Carb Diets are Killing Off Bees ~ .eieriiii e 57
Y o 1Y o - [ o1 P TP O PP PP UOPPPPPPI 57
INErOAUCTION oot e e s e b e e e e eabeee e e e e 57
Methods and Materials  .......coooiiiiiiiiie e 59
B4 RESUITS e 64
4.5: DISCUSSION  ceiiiiiiiiiiiiiiiiee e 68

Appendix: Random Bee Information ., 122

REFEIENCES et e e s e e e s ne e neees 132

CUITICUIUM VITAB e e e e e s 147
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Sample Table of Contents: Creative Dissertation

TABLE OF CONTENTS

ABSTRACT ...ttt e s e e e e e e e a e e e e e e s s s sares iii
ACKNOWLEDGEMENTS ... v
PREFACE ..o vi
1: THE MILLER'S WIFE ...ttt ettt e st e st e e e s e e e senneeeeeanns 1
2: SALTED EARTH ...ttt 80
CURRICULIM VITAE .ttt e e sbra s s e e e e s s s nanes 117
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